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This tutorial demonstrates how to perform a virtual screen for potential inhibitors of FXa using the                               
ligand docking application Glide. You will learn how to generate a protein receptor grid, dock a set                                 
of ligands into the receptor grid, and analyze the docking results.  

Words found in the Glossary of Terms are shown like this: ​Workspace 
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Items that you click or type are shown like this: ​File > Import Structures 
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2. Creating Projects and Importing Structures - p. 1 

3. Generating a Receptor Grid - p. 3 

4. Docking the Cognate Ligand and Screening Compounds - p. 6 
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1. Virtual Screening Prerequisites 
Structure files obtained from the PDB, vendors, and other sources often lack necessary information                           
for performing modeling-related tasks. Typically, these files are missing hydrogens, partial charges,                       
side chains, and/or whole loop regions. In order to make these structures suitable for modeling                             
tasks, we use the Protein Preparation Wizard to resolve issues. Similarly, ligand files can be sourced                               
from numerous places, such as vendors or databases, often in the form of 1D or 2D structures with                                   
unstandardized chemistry. LigPrep can convert ligand files to 3D structures, with the chemistry                         
properly standardized and extrapolated, ready for use in virtual screening. 

In this tutorial, the protein, ​cognate ligand​, and virtual screening ligands have already been prepared                             
in order to save time. However, these preparation steps are a necessary part of a virtual screen and                                   
must be done before docking. Please see the ​Introduction to Structure Preparation and Visualization                           
tutorial for instructions on using the Protein Preparation Wizard and LigPrep. 

2. Creating Projects and Importing Structures 
At the start of the session, change the file path to your chosen ​Working Directory in Maestro to make                                     
file navigation easier. Each session in Maestro begins with a default ​Scratch Project ​, which is not                               
saved. A Maestro project stores all your data and has a ​.prj extension. A project may contain                                 
numerous entries corresponding to imported structures, as well as the output of modeling-related                         
tasks. Once a project is created, the project is automatically saved each time a change is made. 

Structures can be imported from the PDB directly, or from your ​Working Directory using ​File >                               
Import Structures ​, and are added to the ​Entry List and ​Project Table​. The ​Entry List is located to                                   
the left of the ​Workspace ​. The ​Project Table can be accessed by ​Ctrl+T (Cmd+T) ​or ​Window >                                 
Project Table ​if you would like to see an expanded view of your project data. 

 

1. Double-click the ​Maestro​ icon 
○ (No icon? See ​Starting Maestro ​) 

 
Figure 2-1. Change Working Directory option. 

2. Go to ​File > ​ ​Change Working Directory​, 
find your directory, and click ​Choose 
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Figure 2-2. Save Project panel. 

3. Go to ​File ​ ​> Save Project As  
4. Change the File name to ​FXa_Glide 
5. Click ​Save 

○ The project is now named 
FXa_Glide.prj 

 
Figure 2-3. Tutorials panel, showing filtered 
results with “Glide” as a keyword. 

6. Go to ​Help > Tutorials  
7. Next to Filter, type ​Glide 
8. Choose ​Structure-Based Virtual 

Screening Using Glide 
9. Click ​Copy  

○ All the tutorial files are copied into 
your ​Working Directory 

10.Click ​Close 
 
 

 
Figure 2-4. The Import panel, with desired files 
selected. 

11.Go to ​File ​ ​> ​ ​Import Structures 
12.Ctrl-click (Cmd-click) to select files 

1fjs_prep_lig.mae.gz​, 
1fjs_prep_recep.mae.gz and 
50ligs_epik.mae.gz  

13.Click ​Open 
○ Structures are in the ​Entry List 
○ A banner appears confirming 

entries have been imported 
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Figure 2-5. Merge entries. 

14.Shift-click to ​select​ ​1fjs_prep_lig ​and 
1fjs_prep_recep ​in the ​Entry List 

15.Right-click on the ​selection ​ and choose 
Merge 

16.Double click on the new entry to rename 
it ​1fjs_prep_complex 

 

3. Generating a Receptor Grid 
Grid generation must be performed prior to running a virtual screen with Glide. The shape and                               
properties of the receptor are represented in a grid by fields that become progressively more                             
discriminating during the docking process. To add more information to a receptor grid, different                           
kinds of constraints can be applied during the grid generation stage. For a comprehensive overview                             
of constraint options, see the ​grid generation videos on our website or the ​Glide User Manual (​Help                                 
> Help > User Manuals > Glide User Manual​). In this tutorial, we will set a hydrogen bond                                   
constraint in our receptor grid. 

3.1  Identify the binding site  

 
Figure 3-1. Receptor Grid Generation option in 
Receptor-Based Virtual Screening. 

1. Click the ​In​ circle next to 
1fjs_prep_complex ​ to ​include​ it in the 
Workspace 

2. Double-click ​Presets 
○ 1fjs_prep_complex is rendered 

using the Custom Preset 
3. Go to ​Tasks > Browse > 

Receptor-Based Virtual Screening > 
Receptor Grid Generation 

○ The Receptor Grid Generation 
panel opens 

 
Figure 3-2. The Receptor tab of Receptor Grid 
Generation. 

4. Under Define Receptor, check the boxes 
for ​Pick to Identify the ligand 
(Molecule) ​and​ Show Markers 

○ A banner in the ​Workspace ​ will 
prompt you to click on an atom in 
the ligand 
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Figure 3-3. The ligand is defined to be excluded 
from grid generation. 

5. Click on the ​ligand  
○ The ligand is now highlighted with 

a purple box around it 
○ The ligand will be excluded from 

the grid generation 
 

Note​: The purple bounding box defines the 
region that the docked molecule(s) can occupy 
to satisfy the initial stages of docking 

3.2  Define the bounding box dimensions 

 
Figure 3-4. The Site tab of Receptor Grid 
Generation. 

1. Click the ​Site ​ tab  
2. Select ​Centroid of Workspace ligand 

(selected in the Receptor tab) 
3. Click ​Advanced Settings 

○ A green inner bounding box 
appears 

 
Note​: The green bounding box defines the 
region in which the centroid of the docked 
molecule(s) must occupy to pass the initial 
stages docking 

 
Figure 3-5. Ligand diameter midpoint box panel. 

4. Adjust the settings for ​ X ​,​ Y ​,​ ​and​ Z ​sizes 
to ​10 ​,​ 8 ​,​ ​and​ 6 ​Å​ , respectively. 

○ The shape of the green box is 
changed 

5. Click ​OK 
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3.3  Set a hydrogen bonding constraint 

 
Figure 3-6. Search in the Structure Hierarchy. 

1. Type ​ L t ​o zoom to the ligand 
2. In the Structure Hierarchy, click the 

magnifying glass 
3. In the search field, type ​ASP 189 
4. Select ​ ASP 189 

 
Note​: Please see the ​Introduction to Structure 
Preparation and Visualization ​ ​tutorial for 
instructions on how to add residue labels and 
show H-bonds 

 
Figure 3-7. Zoom to selected atoms. 

5. Under Fit, click ​Fit view to selected 
atoms 

 
Figure 3-8. The Constraints tab of Receptor Grid 
Generation. 

6. In the Receptor Grid Generation panel, 
click the ​Constraints​ tab  

7. Click the ​H-bond/Metal (0)​ tab 
○ A banner appears prompting 

selection of the receptor atom to 
be the constraint 

 
Figure 3-9. Constraint defined on ASP 189. 

8. Click an ​oxygen atom​ of the ASP 189 
sidechain 

○ Both oxygens are highlighted 
○ An H-bond constraint is defined in 

the Receptor atoms table 
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Figure 3-10. Run receptor grid generation job. 

9. Change Job name to ​glide-grid_1fjs 
10.Click ​Run 

○ This job will take about a minute  
○ A folder named glide-grid_1fjs is 

written to your ​Working Directory 

 

4. Docking the Cognate Ligand and Screening Compounds  
The minimum requirements for running a Glide virtual screen are a grid file and a ligand file. It is                                     
strongly recommended that the grid file be generated from a protein prepared using the Protein                             
Preparation Wizard and the ligand file be prepared using LigPrep. Additionally, you can choose the                             
scoring function, set ligand- and receptor-based constraints, and define the output. Please see the                           
Glide User Manual for more detail. In this section, we will include the hydrogen bonding constraint                               
that was created in the previous step. 

First, we will dock the ​cognate ligand​, which is a helpful way to benchmark a virtual screen of                                   
compounds with unknown binding activity against a target. If you have followed on from the                             
Introduction to Structure Preparation and Visualization ​tutorial, you can begin at ​section 4.2​. The                           
information gained from this step can help with evaluating poses and beneficial interactions, which is                             
useful for hit finding. Second, we will dock the screening compounds from a prepared ligand file,                               
50ligs_epik.mae.gz​. Both jobs will use the receptor grid file that was generated in the previous                             
step. 

4.1  Prepare the cognate ligand (if needed) 

 
Figure 4-1. Include 1fjs_prep_lig. 

1. Include ​ ​1fjs_prep_lig​ in the ​Workspace 
2. Go to ​Tasks > Browse > LigPrep 

○ The LigPrep panel opens 
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Figure 4-2. The LigPrep panel. 

3. For Use structures from, choose 
Workspace (1 included entry) 

4. Under Stereoisomers, select ​Determine 
chiralities from 3D structure 

5. Change Job name to ​ligprep_1FJS 
6. Click ​Run 

○ A banner appears when the job 
has been ​incorporated 

○ A new group is added to the ​Entry 
List 

4.2  Dock the cognate ligand  

 
Figure 4-3. The Ligands tab of the Ligand 
Docking panel. 

1. Go to ​Tasks > Browse > 
Receptor-Based Virtual Screening > 
Ligand Docking 

○ The Ligand Docking panel opens 
2. Next to Receptor grid, click ​Browse ​and 

choose ​ ​glide-grid_1fjs.zip  
3. In the Ligands tab, for Use ligands from, 

choose ​Files 
4. Next to File name, click ​ Browse ​ and 

choose ​ligprep_1FJS-out.maegz 
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Figure 4-4. The Constraints tab of the Ligand 
Docking panel. 

5. Click the ​Constraints​ tab 
6. Under Use, ​check​ the H-bond constraint 

for ASP 189 
7. Change Job name to 

glide_1FJS_cognate 
8. Click ​Run 

○ This job takes about a minute 
○ A banner appears to show that 

files have been ​incorporated 
○ A new group is added to the ​Entry 

List 

 
Figure 4-5. Binding pose of the docked cognate 
ligand (pink) compared to the crystal structure 
(gray). 

9. Double-click the ​In​ circle next to 
1fjs_prep_complex  

○ The entry is fixed in the 
Workspace 

10. Include ​ the ​first ligand result ​of the 
glide_1FJS_cognate-pv1 group 

11. Include other ​ligand results ​ in turn 
○ H-bonds to ASP 189 are 

conserved 
12.Double-click the ​In​ circle next to 

1fjs_prep_complex 
○ The entry is no longer fixed in the 

Workspace 
 
Note​: Though only the top ranked result is in 
strong agreement with the crystallographic 
pose, all three results accurately capture the 
pose of the ligand in the binding site (with 
varying degrees of success in capturing the 
solvent exposed region) 
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4.3  Dock the screening compounds 

 
Figure 4-6. Select 50ligs_epik in the Entry List. 

1. In the ​ ​Entry List​, ​select​ the group 
50ligs_epik 

 
Figure 4-7. Use ligands from selected entries. 

2. In the Ligand Docking panel, click the 
Ligands ​ tab 

3. For Use ligands from, choose ​Project 
Table (selected entries) 

 
Note:  ​Keep ​glide-grid_1fjs.zip​ as the 
receptor grid 

 
Figure 4-8. The Output tab of the Ligand 
Docking panel. 

4. Click the ​Output ​ tab 
5. Check ​Write per-residue interaction 

scores 
6. Change Job name to 

glide_1FJS_screening 
7. Click​ Run  

○ This job takes a few minutes 
○ A banner appears to show that 

files have been ​incorporated 
○ A new group is added to the ​Entry 

List 
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5. Analyzing Results and Binding-Site Characterization 
Multiple Glide docking results can be viewed in the ​Entry List and be identified by the job name.                                   
Docked results will show the receptor in the first row and the docked ligand(s) in the subsequent                                 
row(s), where they are ordered by best to worst docking score, or Glide Gscore if Epik state                                 
penalties were not applied in LigPrep. The Glide Gscore is broken down by van der Waals                               
electrostatic components and can be seen in the ​Project Table ​, using the Property Tree.  

In this tutorial, to save time, Glide XP with XP descriptor information has already been performed                               
using a subset of the screening compounds. For more details on running Glide XP, see the ​Glide                                 
User Manual (​Help > Help > User Manuals > Glide User Manual​). XP descriptor information shows                               
the individual components of the scoring function and how various rewards and penalties contribute                           
to the Glide Gscore. We will view results in the XP Visualizer. 

Finally, we will analyze the binding site using SiteMap. SiteMap characterizes hydrophilic,                       
hydrophobic, acceptor, and donor regions of a receptor. This is useful for learning more about an                               
active site, predicting a binding site in an apo structure, or identifying possible allosteric sites.                             
SiteMap ranks the potential binding sites with a druggability score, which can be viewed in the                               
Project Table​. The output from a Glide virtual screen can be overlaid with SiteMap information to                               
examine how well the docked ligands explore the various regions in the binding cavity. Sites                             
identified by SiteMap can be used to create receptor grids for virtual screening experiments. This                             
can be useful for exploring sites without a known active compound. 

5.1  Visualize the results using Pose Viewer 

 
Figure 5-1. Pose Viewer panel. 

1. Go to ​Tasks > Browse > 
Receptor-Based Virtual Screening > 
Pose Viewer 

2. Select newly generated group titled 
glide_1FJS_screening_pv 

3. Click ​Set Up Poses 
4. Check ​Display per-residue interactions 
5. Step through the results using the ​right 

and ​left ​ arrow keys 
○ Ligand poses are displayed in the 

Workspace 
○ Residues are colored according to 

their interaction energies, ranging 
from green (favorable) to red 
(unfavorable) 
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5.2  Analyze the results 

 
Figure 5-2. Glide Primary properties shown in 
the Project Table. 

1. In the ​Project Table ​, click the Property 
Tree ​ icon 

○ The Property Tree appears on the 
right of the ​Project Table 

2. Click the ​ All ​ box twice 
○ All boxes are deselected 

3. Click  the ​ Glide ​box 
4. Click​ Secondary 

○ Only the Glide Primary properties 
are shown 

 
Note​: Please see ​Knowledge Base Article 1027 
for more information on the difference between 
docking score, Glide gscore, and glide emodel 
score. 

5.3  Visualize pre-docked XP results 

 
Figure 5-3. The XP Visualizer panel. 

1. Go to ​Tasks > Browse > 
Receptor-Based Virtual Screening > 
Visualize XP Interactions 

○ XP Visualizer opens 
2. Click ​Open 

 
Figure 5-4. Choose the Activity Property. 

3. Choose ​factorXa_xp_refine_pv.maegz 
and click ​Open  

4. Choose ​Glide Gscore ​ as the activity 
property, click ​OK 

○ The table is populated with the XP 
results  

○ Individual terms of the scoring 
function are colored as red 
(penalty) or blue (reward) 
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Figure 5-5. The XP Visualizer showing rewards 
(blue) and penalties (red) to the Glide Gscore. 

5. Click ​Export Data ​to export the 
spreadsheet as a ​.csv​ file 

 
Figure 5-6. Hydrophobic enclosure reward 
shown in the Workspace. 

6. Click on the ​indented ​ ​colored entries​ to 
visualize in the ​Workspace 

5.4  Identify a binding site with SiteMap 

 
Figure 5-7. Fix 1fjs_prep_complex in the 
Workspace. 

1. Double-click the ​In​ circle to fix 
1fjs_prep_complex ​in the ​Workspace 

2. Go to ​Tasks > Browse > Structure 
Analysis > Binding Site Detection 

○ The SiteMap panel opens 
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Figure 5-8. SiteMap panel. 

3. Under Task, select ​Evaluate ​ ​a Single 
binding site region 

4. Click on ​ ​the ​ ligand ​ in the ​Workspace 
○ The ligand is highlighted 
○ SiteMap removes the ligand from 

the calculation 
5. Change the Job name to ​sitemap_1fjs 
6. Click​ Run 

○ A banner appears when the job 
has ​incorporated 

○ A new group is added to the ​Entry 
List  

 
Figure 5-9. SiteMap results in the Workspace. 

7. Include ​ the ​sitemap_1fjs_site_1 
8. Type ​L 

○ Various surfaces are shown 
representing different regions of 
hydrophilic property; hydrophobic 
(yellow), acceptor (red), donor 
(blue) 

○ The white site-point spheres each 
represent ~1 ​Å​3 

9. In the ​Entry List​, click the ​S​ next to 
sitemap_1fjs_site1 to ​toggle​ the surfaces 
associated with the SiteMap 

 
Note:​ To find all possible binding sites using 
SiteMap, under Task select ​Identify top-ranked 
potential receptor binding sites 
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5.5  Generate a Receptor Grid from SiteMap 

 
Figure 5-10. The Receptor tab of Receptor Grid 
Generation. 

1. Go to ​Tasks > Browse > 
Receptor-Based Virtual Screening > 
Receptor Grid Generation  

2. Click the ​Receptor​ tab 
3. Check ​Pick to identify ligand ​ and 

choose ​Entry 
○ A banner appears prompting to 

pick an atom 

 
Figure 5-11. A receptor grid using SiteMap to 
define a potential binding site. 

4. Click on a ​site point​ in the ​Workspace  
○ All site points are highlighted 

 
Figure 5-12. The Receptor tab of Receptor Grid 
Generation. 

5. Change Job name 
to  ​glide-grid_1fjs_sitemap 

6. Click ​Run  
○ This job  takes about a minute  
○ A folder named 

glide-grid_1fjs_sitemap is written 
to your ​Working Directory 
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6. Conclusion and References 
In this tutorial, we completed a workflow for virtual screening using Glide. We generated a receptor                               
grid with a hydrogen bond constraint, which was used in ​cognate ligand ​docking as a positive                               
control to set up a virtual screen of test ligands. Then, a series of screening compounds were                                 
docked and the results were viewed using Pose Viewer, with known actives being found as the top                                 
hits. Pre-run results from a Glide screen using the XP scoring function were visualized to see which                                 
parameters were strongly influencing the score. SiteMap was used to explore the binding site and                             
generate another receptor grid. The information gained from this virtual screen can be used to find                               
ligand candidates for further ​Structure-Based Lead Optimization with Glide & MM-GBSA​. 
 
For further information, please see: 
Maestro 11 Training Portal 
Introduction to Structure Preparation and Visualization 
Glide User Manual 
 

7. Glossary of Terms 
cognate ligand​ - a ligand that is bound to its protein target 

Entry List​ - a simplified view of the Project Table that allows you to perform basic operations such as 
selection and inclusion 

included​ - the entry is represented in the Workspace, the circle in the In column is blue 

incorporated​ - once a job is finished, output files from the working directory are added to the project 
and shown in the Entry List and Project Table 

Project Table ​ - displays the contents of a project and is also an interface for performing operations 
on selected entries, viewing properties, and organizing structures and data 

Scratch Project ​ - a temporary project in which work is not saved, closing a scratch project removes 
all current work and begins a new scratch project 

selected​ - (1) the atoms are chosen in the Workspace. These atoms are referred to as "the selection" 
or "the atom selection". Workspace operations are performed on the selected atoms. (2) The entry is 
chosen in the Entry List (and Project Table) and the row for the entry is highlighted. Project 
operations are performed on all selected entries 

Working Directory ​ - the location that files are saved 

Workspace ​ - the 3D display area in the center of the main window, where molecular structures are 
displayed 
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https://www.schrodinger.com//sites/default/files/s3/mkt/Documentation/2019-4/docs/Documentation.htm#academy_tutorials/SBLO_Glide_MMGBSA/SBLO_Glide_MMGBSA.htm
https://www.schrodinger.com/training/maestro11/home
https://www.schrodinger.com//sites/default/files/s3/mkt/Documentation/2019-4/docs/Documentation.htm#academy_tutorials/Visualization_Preparation/Visualization_Preparation.htm
https://www.schrodinger.com/sites/default/files/s3/mkt/Documentation/2019-4/docs/Documentation.htm#glide_user_manual/glide_user_manualTOC.htm
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